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New Sheriff in Town
By Jay Castillo

Editor's Page

There‘s a new sheriff in town — and I’m it! I have taken over as Managing Editor 
of the Journal on an interim basis, replacing Bob Jarecke. Bob, after long and 
faithful service, is lightening his Washington Apple Pi workload. He has been the 
driving force behind the development and evolution of our electronic Journal, and 
the results have been outstanding. He deserves the praise and gratitude of our 
membership. The good news is that Bob will continue to advise and contribute, 
and he will be assisting me as I transition to my new interim role. We still need 
a permanent Managing Editor, so please, if you have some project management 
experience, enjoy writing, and relish working on a team, come aboard!

In this edition of the Journal, we feature an article by Bob on controlling the 
intake and disposal of email spam. We also include a helpful iTunes tip for clas-
sical music lovers, and one on iPad reading recommendations. Don’t miss Travis 
Good’s article on taking advantage of unique iPhone capabilities in an emergency. 
We also have the usual fare, including Tips and Tricks and a cartoon. We hope we 
have something for everyone.

Our goal as we assemble each edition of the Journal is to provide informative and 
occasionally entertaining articles about matters that are of interest to you. Please 
let us know what you would like to see in the Journal. Or, best of all, write some-
thing and send it to us! That would help us achieve another important goal: to 
publish on time. Gathering content is our biggest challenge. So join in!

http://www.wap.org
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President’s Page

Moving Forward
By Jay Castillo

It’s a new year, so may you be prosperous and wiser, 
and may all your Mac problems be easily solved. 
It’s time for your Washington Apple Pi Management 
Committee to look ahead to determine how we can 
be better and smarter as an organization, and ensure 
that you, the Pi members, are getting the most from 
your membership. As we do this, we will always 
benefit from your feedback, and suggestions for 
improvement. So please participate in making the Pi 
a better place for all of us.

A New Plan
We will be revisiting our strategic plan of two 
years ago to assess our progress and evaluate 
our circumstances. A well-known military axiom 
states, “No plan survives contact with the enemy.” 
Management courses teach us that the plan is 
nothing; planning is everything. Careful and objective 
thinking must be the basis of our view of the future. 
We must be realistic about our objectives and most of 
all be realistic about the resources available to us to 
accomplish our objectives. So on to our next plan. Are 
you willing to be a part of it?

We few, we happy few
I am well into my second year as the President 
of the Washington Apple Pi.  The presidency has 
been an honor and a significant responsibility. It’s 
also a challenge. I have to discharge my fiduciary 
responsibilities to ensure that our funds are spent 
wisely and to the benefit of the membership. I also 
must ensure that commitments we undertake are 

beneficial and practical. Here is where resource 
management becomes important. Our most 
important resource is the volunteer men and women 
who really get things done. I am impressed with the 
vigor, tenacity, and cheerfulness of those relatively few 
Pi members who do the real work of delivering what 
the Pi promises. Ensuring that the Pi Web services are 
reliable and up to date, making the monthly General 
Meeting informative, functional, and nourishing 
(Coffee! Doughnuts!), and executing the plans that we 
make are done by a few dedicated individuals who 
always answer the call. To you, I declare a heart-felt 
“Thank you.”  I will continue to make the call for 
additional volunteers. While there are specific jobs 
that need to be filled, we will accept anyone who is 
willing to chop wood or carry water. There is always 
work to be done. Help us make this year a great one 
for the Pi.

http://www.wap.org
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Pi Membership Benefit #2
Monthly General Meetings

Pi General Meetings are a great source of information presented in a friendly, comfortable setting. The meetings are currently being held on the George Mason Uni-
versity campus in Fairfax, VA. 

A typical meeting will look like this: 

•• Begins @ 9:30 a.m. with Questions and Answers hosted by  
Lawrence Charters or backup.

•• 10:00 a.m. Club business is covered by the current Pi President.

•• 10:30 a.m. Coffee Break – fresh coffee and pastries as provided  
by Kitty Richardson.

•• 10:45 a.m. Main presentation by assortment of presenters,  
some Pi members, some not.

•• 12:00 p.m. Close out of meeting or pizza lunch if there is an  
afternoon session.

The benefits of the meeting are many and varied. To start with you will 
most likely learn something new and beneficial from the presentation 
or other meeting attendees. The camaraderie, too, is great as you mix 
and mingle with other Apple computer enthusiasts.

If you can’t attend the monthly Pi gathering, you are missing out on a 
super benefit of the club. But not to worry, the meeting is being video- 
taped as well as simultaneously broadcast on the Internet. During 
the next monthly meeting, just check in on the Web broadcast at the 
following url:

http://www.ustream.tv/channel/wap-general-meeting

Lawrence Charters enlightens the audience (yet again) as he uses the room’s document 
reader to project an image of his iPad’s screen. The dark cast behind Lawrence adds to the 
mystery of the moment.

Pi Quick Notes

http://www.wap.org
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Find My iPhone to the Rescue
By Travis Good

“Help, I’m lost in a forest!” That’s the first 
thing my daughter Kelsey said when she 
called me one recent evening, quickly 
followed by, “And don’t tell mom!” It 

seems my daughter had decided to go for a run in Scotts Run 
Nature Preserve on her way home after hockey practice. Being 16 
and so feeling indestructible, she didn’t think ahead about any 
possible difficulties with an early evening run. She just figured 
that a jog through the forest would be fun, so she put on her run-
ning shoes and headed out.

The outing started off well. Kelsey enjoys the obstacle course that 
is a run along a forest trail. Not until she started to have trouble 
seeing did she realize that: (1) it was getting dark; (2) she didn’t 
know where she was; and (3) she had no idea how to get back to 
her car.

She wandered around for a little while trying to find a road, a 
sign, or even the Potomac River —  anything to help guide her 
back to civilization — without success. While a bit of evening light 
still hung in the air, she called me in a minor panic. “Dad! Help! 
I’m lost in a forest!”

It’s amazing how a geek’s mind works: the first thought I had 
was, “Hey, I can figure out where you are by using the Find My 
iPhone! application." We got this service as a part of MobileMe, 
and it has proven its value time and again in locating our daugh-
ters’ misplaced phones. I knew from experience that with Find 
My iPhone  I could locate Kelsey’s phone on a map. If she moved, 
I could pinpoint her new location — and so on. As she moved, I 
could track her movements on a map and guide her back to her 
car. Our exchange went like this:  

1)	 “I see where you are. Now I want you to walk in a direc-
tion you think is right.”

2) 	 “No, that took you deeper into the forest. You need to 
swing about 120 degrees to the right of the direction 
you were headed. Start walking and I’ll update you in a 
few minutes.”

Figure 1: 
Here is the way out of the forest 
that my daughter and I devised.

Software Tutorial
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3) 	 “OK, I see where you are. You’re heading in the right di-
rection. Soon you should see the backs of some houses. 
These houses are on a cul-de-sac. Head toward them to 
get to the road.”

4) 	 “What? You say there’s a fence along the backs of those 
houses? OK then, follow the fence to the right and it’ll 
eventually get you to the main road.”

This is as far as I got in helping her because the next thing I heard 
was, “Daddy! Daddy! I see my car!!!” I could hear the relief in 
Kelsey’s voice, and see the worried look on my wife’s face start to 
evaporate. (Yes, of course I told mom!)

Happy daughter. Relieved wife. Mission accomplished!

Figure 2:  
With the release of iOS 4.2, Find My iPhone is now free for anyone with an 
iPhone 4, a 4th generation iPod Touch, or an iPad, whether or not you sub-
scribe to MobileMe. You can download it from the App Store, use it to easily 
locate a missing device on a map, and have it display a message or play a 
sound.  You can remotely lock or wipe data from a lost device, to protect your 
private information — and you can even track your teenager and help her find 
her way home.

Software Tutorial

http://www.wap.org
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Importing Classical Music into iTunes:  
An Improved Experience
By Jay Castillo

Suffering for my Art
Conventional wisdom is that iTunes is not optimized to manage 
classical music collections. Over the years I have imported my 
classical music CDs into various versions of iTunes, in which the 
CD tracks are imported separately and managed independently. 
In older iTunes versions, I could, with some effort, create playlists 
in which I had collected and transferred the tracks that made up 
a classical music selection — typically three, four, or more. Then, 

by selecting a playlist, I could hear the proper movements of the 
selection in order. I was vaguely aware that there might be third-
party utilities or scripts that would import classical music selec-
tions as linked tracks, but I didn’t pursue them. As a result, when 
I played music using the Shuffle command, for example, the first 
movement of Beethoven’s Seventh Symphony (absolutely sub-
lime!) might be followed by a raucous rock tune. I would much 
rather hear the complete symphony as a selection.

Aha! Joining Tracks
Recently, I imported some classical music CDs using iTunes 10. I 
discovered that I could readily join the tracks to create a single 
selection, making life a lot easier. Here is the process for those 
who want to take advantage of it.

How It’s Done
It’s straightforward, but there are a few requirements that you 
need to be aware of. Begin by opening System Preferences and 
selecting the CDs & DVDs icon. The window that opens allows you 
to specify what your computer should do when you insert various 
CDs and DVDs.  Scroll down to the “When you insert a music CD” 
line and select “Open iTunes” in the instruction box. Now insert 
your classical CD. iTunes will open a window like the one in Figure 
1, that shows the individual tracks on your CD, accompanied by 
a dialog box that asks you whether you would like to import that 
CD into your iTunes library.  Select “NO!” This is counterintuitive 
but very important. You cannot link the CD tracks together after 
they have been imported into iTunes! 

Figure 1. When you insert your 
music CD, you will see this win-
dow and dialog box.  Make sure 
to select “No.”

Software Tutorial
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Once you have clicked “No,” the dialog box 
will close, leaving the window that shows all 
the tracks on your CD.  In the example that 
illustrates this article, I inserted a CD with two 
Beethoven symphonies, each of which has 
four tracks. 

The next step is to select the tracks to be 
joined. You can highlight them using the 
command key-click method. Now come two 
more critical requirements.  First, the tracks 
you select to link must be listed in ascending 
numerical order. It will not work if the order 
is reversed. Second, the selected tracks must 
be contiguous. There cannot be intervening 
non-selected tracks.

In this example, I selected tracks one through 
four, which together comprise Beethoven’s 
first symphony. Now, in the iTunes tool-
bar, select “Advanced,” then select “Join CD 
Tracks.” The CD track list, shown in Figure 2, 
now shows a new Track 1, consisting of the 
four tracks I selected to be joined.  The joined 
tracks are indented and bracketed. Repeat the 
process for the next set of tracks, and the final 
CD track list, shown in Figure 3, will show two 
tracks, one for each symphony.

Now import the CD into your iTunes library, 
by clicking on the “Import” button on the bot-
tom right corner of the iTunes window. The 
CD will appear as two tracks, Symphony #1 
and Symphony #2. You can now manage each 
symphony as you would any single iTunes 
track.  
Enjoy!

Figure 2. After you join tracks, you will see a window like this one.  The tracks you selected are bracketed and indented 
under the new Track 1. 

Figure 3. This window shows the CD after I have finished joining tracks. I now have two tracks, one for each symphony. 

Software Tutorial
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Living with Spam
By Bob Jarecke

Cover Story

Benjamin Franklin told us that the only certainties 
in life are death and taxes. I suggest there is a third 
certainty: spam. This electronic menace drags down 
computing worldwide. It results in lost productivity 

and data, costing the business world huge sums of money. It 
is frustrating and costly for individual users like us as well. We 
try to thwart email spammers using spam filtering. We change 
email addresses, and in extreme cases limit our connection to the 
Internet. Is there a better way?

The focus of this article is junk email — unsolicited email 
messages, and unwanted email messages. Unsolicited email 
is by far the most prolific and the most infuriating. Unwanted 
email may not be as obvious, but it could end up taking up 
more of your time to deal with it. In the end, either kind of 
email spam requires action on your part to make the best of a 
tiresome situation. Below you will find suggestions for how best 
to minimize junk email, and how best to keep up with the spam 
that gets through. The troublesome spam may never stop, but at 
least you will know how to better deal with it.

Minimizing electronic spam
Minimizing junk email is the first line of defense. How to best do 
this depends on the type of email you are dealing with.

Unsolicited emails are typically sent out en masse to large 
lists of email addresses. How do the spammers get their email 
address lists? They can be harvested in a variety of ways. Some 
are obtained from Web pages, including email discussion lists 
that are posted on the Web. Some come from emails that have 
your email address in them and then have been forwarded. Yet 
others are generated by spam robots (spambots), which can crank 

out endless email address combinations with the certainty that 
some of them will be legitimate. The last, and most surreptitious, 
technique involves planting code on a computer (almost 
exclusively a Windows computer) that forwards the email address 
book of the user to a spammer. This malicious code can infiltrate 
your computer’s operating system via a spam email message. In 
many cases the virus is embedded in an attachment to the email 
message (see the sidebar item entitled “Email Attachments: Friend 
or Foe”). It can also be introduced to your Mac via a clickable link 
in an email message. If you click on the link, you are taken to a 
Web page, and when you connect with it, malicious code may be 
downloaded.

How the bad guys got your email address is not necessarily the 
issue; the point is you have been spammed. Whether the message 
is trying to sell you Viagra, or asking you to help move a large 
sum of money out of an African country, or trying to get you to 
provide an account name and password, the theme is the same: 
the spammers are trying to separate you from your money. An 
inbox replete with easy-to-spot, unsolicited spam emails is shown 
in Figure 1.

Manage your email address(es)
Don’t lose heart though. There are a couple of ways to protect 
your email address.

Many email addresses that are generated for the user follow a set 
naming standard. A case in point is the email service offered by 
the Washington Apple Pi, which has a naming nomenclature of 
first name /dot/ last name @ wap.org. In this case, it doesn’t take 
spammers very long to figure out your email address and pepper 
it with ads for Rolex watches. The next time you set up an email 

Spam!

Whether the message 

is trying to sell you 

Viagra, or asking 

you to help move a 

large sum of money 

out of an African 

country, or trying to 

get you to provide an 

account name and 

password, the theme 

is the same: the 

spammers are trying 

to separate you from 

your money.
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address, consider one that is unconventional. Use many characters, 
numbers, and symbols to create a “complex” email address that will 
be much harder for a spammer to figure out.

The other ways to protect your email address work for unwanted 
emails as well as unsolicited emails. One option is to create an alias 
email address, i.e., an address that points to your actual email address. 
These are offered by Internet Service Providers and other email service 
providers like Apple’s MobileMe service. You need not worry about the 
makeup of the alias address, since you are likely to be using it only 
temporarily. Aliases are good for certain types of activities like signing 
up for contests, or entering “required” addresses on forms in order to 
get non-critical services. If the alias gets plagued with spam, delete it 
and create a new one.

Another option: Consider having more than 
one email account. This affords a second 
or third option that you could use when 
communicating with businesses and Web 
sites that might, for marketing reasons, pass 
your address along to others. Like alias email 
addresses, using multiple accounts requires 
some discipline. If you use a particular 
account for banking, you probably don’t 
want to use the same account for a contest 
to win an iPad; the marketing group holding 
the contest will surely use your contest entry 
to send you more marketing. (Speaking of 
passing along email addresses, could you be 
guilty too? See the sidebar item entitled “Take 
My Email Address — Please!”)

Manage your unwanted email  
messages at the source
Unwanted email messages are unwelcome 
but generally not unsolicited. This email ends 
up in your inbox because of some online 
contact you have made, and although these 

contacts may have been initiated with the best intentions, they now 
have become unimportant, uninteresting, or worse, a nuisance. These 
unwanted emails can be the result of interaction with Web sites or 
social groups, or of ordinary email messages to family and friends.

Have you ordered anything online? Did you sign up for a regular, 
informational email from some group or activity? Do you keep in 
regular contact with many of the folks on your contact list? All of these 
activities can result in loads of emails showing up in your inbox. Let’s 
look first at activity on the Web.

In many cases, when you register on a Web site you are required to set 
up an account name and password, and provide an email address as 
part of the process. In the usual accompanying fine print agreement, 

Figure 1. Here is a 
list of emails from the 
Pi’s Office email folder. 
Looks like the spam 
filter needs some 
tweaking. Some of the 
Subjects are really 
amusing: check out 
the first one — he, he! 
Oh, you don’t know 
Mandarin? Sorry.

Cover Story
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which you must sign off on to complete the registration, by default you will be 
placed on an email list that will be used to send email notices, alerts, and possibly 
marketing announcements. Only by opting-out, by deselecting that option in 
the agreement, will you be spared what could be a barrage of emails. Automatic 
opting-in is commonplace; the onus is on you to choose otherwise. The good 
news is that most legitimate emails will have a link, generally near the bottom, 
that takes you to a Web page giving you the choice to stop (opt-out) the unwanted 
emails. The bottom line: when registering on Web sites, read the fine print; it could 
save you some email clutter. Email aliases, mentioned above, are ideal for handling 
such sites.

Another set of unwanted emails results when you agree to be contacted by a group, 
organization or business enterprise. The subject matter could be financial alerts or 
notices, news updates, political information, or special product-marketing notices. A 
good example would be an alert from your bank that you are reaching a low balance or 
a deposit has been made. The key difference typically, in most of these cases, is that you 
initiated the request for the email by selecting the option within your account settings 
on the entity’s Web site. These emails can be turned off by returning to the site’s Web 
page and unchecking the particular email notice option in your account settings.

Dealing with the unwanted emails is important because it might be affecting your 
handling of more crucial or time-sensitive messages. Ask yourself this question: Do 
you find that you have too many emails in your inbox that you have not read? In 
Apple Mail, this would be shown by a host of blue dots indicating unread email, 
and if your mail is displayed chronologically, the unread emails can stretch back 
for days with important ones interspersed between junk. Before promising to do 
better, remove the unread emails from the equation. No, you need not delete 
them, just set them aside. So how might one do that?

To move a block of emails, in this case unread emails, you need to sort them into 
a group that can be moved en masse out of the Inbox. (I know, this seems coun-
terintuitive; unread mail should be in your Inbox, but, in this case, we are talking 
about gobs of unread emails that are a mental block to reviewing any emails.)

The quickest way to group the entire batch of unread emails would be to click on 
the Message Status column header – the one in which all the blue dots reside. Or 
you can click on View in the Mail menu and select Sort By > Message Status.  

All of the unread messages are now grouped in sequence. Now, create and ap-
propriately name a new Mailbox into which you can move the entire group of 
messages. These relocated messages are still available for review and disposition, 
but they are not cluttering up the Inbox and keeping you from dealing with the 
other, more important ones waiting there. When the most important emails are 
dealt with, go back to this Mailbox with the emails you set aside, and deal with 
them accordingly.

A final group of unwanted emails are the more personal ones —those from family 
and friends — and these are a bit tricky to deal with. Again, it was your contact 
with kin or acquaintance that got the ball rolling, and you can’t deal with the 
resultant barrage of emails by just opting out. So, what kind of emails are we 
talking about?

Do you find you have lots of emails (and I mean lots) from the same person? Or 
do you find yourself inundated with too many emails from family and friends, 
more than you have time to answer? The remedy is not easy and may take some 
courage; the words “tough love” come to mind.

In the case of being bombarded with jokes and cartoons by a well-intentioned 
family member or friend, a “knock-it-off” reply might offend. You need to explain 
diplomatically that although you appreciate their sending you the humorous 
messages, you don’t have time for them, so please, for now, take you off their 
“joke” email list. If these people ignore your pleas, you can next explain that your 
spam filtering has been set up to move their emails to a separate folder, and you 
may unintentionally miss more important emails from them, so it might be better 
if they remove you from the list.

As for the host of patriotic and inspiring messages that are being forwarded 
by many folks, your decision to cut them off is a wee bit harder. Some of the 
messages are worth viewing, but many have a hook at the end that asks you 
to forward it to others. In my case, I have a personal rule of not inundating 
other friends and family with these onerous emails. It is more about personal 
discipline in this case. If the decision is too hard, filter them to a separate folder 
using a Rule in Preferences. At least they will be out of your inbox and you can 
then make a thoughtful decision of when and how to deal with them at your 
leisure.

Cover Story
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Another option, which is not directly related, is to become a member of Facebook 
and keep your “friends” (family and others) updated on your activities through 
that medium. This would keep the folks informed and eliminate long explanatory 
emails about how things are going. Besides that, it is a great way to keep up with 
some of the goings on of the family, especially the younger ones, should they 
decide you are worthy of “friend” status.

Filtering spam
Of course, none of these tips can stop all email spam from getting through. You 
need to learn how to use the “big guns:” spam filters. Most (if not all) current email 
applications have a built in spam filter or “Junk Mail” filter, as Apple Mail refers 
to it. While using your email program’s built-in spam filtering is okay, there are 
also third-party applications dedicated to the task, and they can be used quite 
effectively against nuisance emails. In either case, you need to set up the filtering 
before the application can properly sorted or deleted annoying emails.

Setting up spam filtering in Apple Mail is very simple. Email is either Junk or Not 
Junk; mark it accordingly using the convenient toolbar tool. The whole process 
is progressive; the more you mark spam as Junk Mail, the better Mail recognizes 
what is good email and what is not. Full instructions are available via Help in 
Mail’s menu.

All other spam filter applications work in much the same manner as Apple Mail’s 
filtering process, but keep in mind that those applications have one, and only one, 
purpose: to filter email spam. It thereby follows that they should do a very good 
job. I personally use SpamSieve, and over the years it has become exceptionally 
good at its assigned task. Some spam does still get through, but if it does, it is most 
likely because a new spam variant has surfaced. The bottom line: set up a spam 
filter and keep up with marking spam or good emails accordingly as time goes on.

Please note, if you elect to use a third-party spam filter, it might ask that you turn 
off Mail’s Junk Mail filter. Such is the case for SpamSieve, the spam filter I use. It 
requires this so there are no filtering conflicts.

There is one more technique to dispensing with the most bothersome spam 
emails, and it involves using Rules in Mail Preferences. I have several rules set up 
so that an email falling within its criteria is deleted; no side trip to the Spam folder, 

just straight to the dustbin. Figure 2 is a screen shot of one such rule that deals 
with the ubiquitous ads for Viagra.

For those of you who actively use your WAP email account(s), the Pi employs a very 
effective email filtering software program called SpamAssassin. This open source 
software screens every piece of email that comes through the Pi’s email server 
using a plethora of up-to-date filtering criteria to assign point values to various 
aspects of each email message. If there are enough “offending“ aspects in the 
email and the associated point values exceed a set limit (the default point setting 
is five), the email will be marked as spam. When your email client retrieves this 
mail, it will more than likely end up in your Junk Mailbox. If you access your email 
via Webmail, these emails will have notification that they were judged spam and 
there will be an alert message so stating. Figure 3 is an example of an alert relating 
to an email sent to a Pi account that SpamAssassin assesses to be spam. Note the 
detailed point criteria used to make the determination.

Figure 2. Depicted here is a “Viagra” rule in Mail Preferences. If the word shows up in 
the Subject line or within the message, the email does not pass Go, does not collect 
$200, but goes directly to the dustbin!
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A small side note regarding Webmail: I personally do not use 
it unless I am having trouble receiving or sending email via my 
regular email client, Apple Mail. I like to have email from all my 
accounts show up in one spot where I can effectively manage all 
my messages.  The versatility and interconnectivity of Mail is also 
a plus. What’s not to like?

For those of you who feel you are getting too much spam (or if 
you are a sadist, too little), you can make manual adjustments 
to the Pi’s email service via your Pi Connect Web page. Figure 4 
shows what the Filter tab settings look like. If you feel the amount 

of spam you are getting in your WAP email account is too much, 
adjust the point setting lower. Keep in mind that with a lower 
threshold limit more “good” email could end up designated as 
spam; therefore it will behoove you to review all of this email 
to ensure there are no important messages that have been 
mislabeled as spam. Just how to conduct the spam review is 
covered next.

Dealing with spam emails
Now that you have done what you can to minimize spam emails 
and filter the emails you do get, you should make it part of your 
email review process to check the Spam folder each time you 
check for new emails. If you keep the Spam folder cleaned out (or 
at least cleaned up), making decisions on the few spam messages 
that get through will be a lot easier.  To take it one step further, 
discipline yourself to deal with the new emails in the Spam folder 
before you look in your inbox. View the reading of your “regular” 
email as a reward for first cleaning out the spam emails.

In some cases, you may have been away from your computer 
for a while, long enough to build up a hefty number of emails 
in your spam folder. Sorting through the long list of emails is 
no picnic, but there are a couple of techniques that can weed 
out large groups at once. Step one: select one of the most 
obvious spam emails, such as the one with all the Chinese 
lettering in the Subject. Step two: click on the Subject column 
header and this will sort all your emails by Subject – in this 
case all emails with Chinese language in the Subject line. If the 
highlighted email is no longer visible because the list exceeds 
the boundaries of your viewing window and the sort has the 
email listed out of view, just tap the down arrow key; this will 
move you to the next message in the list and also bring that 
original email you highlighted into view. Step three: highlight 
the entire group of Chinese character messages and trash them. 
Sorting your spam emails by Subject or From can quickly group 
unwanted emails and allow you to make a wholesale decision 
about them.

Figure 3. Reader, beware! This 
spam alert message precedes 
any email message sent to a 
WAP email account and judged 
to be spam. The assessment 
of why it is considered spam is 
quite detailed.

Cover Story

http://www.wap.org


16 of 34

Washington Apple Pi

Journal January – February 2011

Ultimately, some spam email messages will have to be evaluated 
individually. Start your review of your spam at the top-most 
message, highlight it and then with your finger on the Delete key, 
review, decide, and delete if the message is spam. If you run into 
a message that is truly not spam, use the tool or menu selection 
to mark it as good, and after it has been moved or removed to the 
inbox, go back to the reviewing and deleting procedure. The more 
often you review your spam, the easier it becomes for you to spot 
emails that are of no interest to you. But, how about those emails 
in the spam folder that look legit?

The best advice about email messages that look legitimate: if you 
don’t know the person, it is inconsequential. Don’t be tempted to 
open any attachments, click on any links, or even reply back. Delete 
the message and purge or empty your trashed emails.

Encouraging Words
In the end, email spam is here to stay. Regrettably. And it is foolhardy 
to think that all junk email could be banished, and even crazier to 
think the email polluters could be punished for the mess they create. 
However, with an understanding of the topic and some discipline, you 
can use the techniques described here to better deal with it.

Consider the above options and let us know what works for you. Or if 
you have other tried-and-true methods, just send an email message to 
feedback@wap.org to pass them along. We can include your input in 
future writings on the topic, or perhaps as a letter to the Editor. What 
say you?

Figure 4. This screen shot shows the Junk Filter settings tab at the E-Mail option on the Pi’s 
Connect page. Every Pi member has an option to adjust spam filtering on his or her WAP email 
account(s).

Spam!
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Email Attachments: Friend or Foe?

There was a recent exchange on the Pi’s TCS Forum 
about viruses being transmitted via email. While 

most Mac experts claim that there are, as yet, no 
viruses that can infect Mac OS X, a Mac user can pass 
along a Windows virus to their unenlightened PC-user 
friends or family members. It is therefore important 
to be wary of  all email attachments, images or 
otherwise.

The question was this:

What is the difference between remote images in 
HTML messages and attached images that friends 
will send me, which mostly appear in the body of a 
message without me having to do anything? Why is 
one a potential danger and the other is not?

The answer, as provided by the Pi’s General 
Meeting Q&A guru Lawrence Charters, addressed 
the questions from a couple of  angles. In several 
paragraphs on the topic, Lawrence replied:

They both are potential dangers, but in different 
ways. And they both are far more dangerous in the 
Windows world.

First, an attachment: An “attachment” in an email 
is a file that has been encoded as part of the SMTP 
(Simple Mail Transport Protocol) stream of that 
message. If you think of an email as a file transfer 

(which it is), the photo is turned into text (since 
mail is always 7-bit text), wrapped up in metadata 
that tells the recipient client program what it is, 
and embedded in the message file. When you 
receive the message, your email client sees that 
there is an attachment, decodes the text into a 
photo, and attaches it to your email. The photo can 
be displayed in-line, as part of the message, or not; 
sometimes you must manually tell your mail client 
to display or download the message. But in either 
case, the photo is _part_ of the message.

Now, what is the danger? The danger is that the 
“photo” may be something other than a photo. It 
might be a program that says, “Erase David’s hard 
drive.” No such programs exist in the Mac world, 
but they are fairly common in the Windows world. 
Hackers have been feverishly at work trying to 
create malignant Mac programs for the past 25 
years. Just think of the prestige and prison sentence 
for the first guy to succeed!

For remote images, it is a very different matter. The 
photo or any other file is never embedded in the 
text stream. Instead, the message has instructions 
which point to an image or file on an external 
server. When you read the message, your email 
client will then initiate a request for that external 

file. A good hacker will send you a message with a 
unique serial number, so when your client requests 
the external file, the server records that “image so 
and so was requested by victim 5419038527748,” 
and then they use a simple database to determine 
that 5419038527748 is really david.harris@
hellokitty.com. This tells the spammers and 
hackers, “We’ve got a live one!”

In the Windows world, it gets even more dangerous, 
as Outlook has the ability not only to request the 
remote file, but to execute it. So long, hard drive! 
Or whatever action the file is set to perform.

There are other dangers. Spammers can 
deliberately send you multiple large files to fill 
up your mail box and deny you access to mail 
(a certain corporation tried this against a U.S. 
regulatory body a couple years ago, hoping the 
regulators wouldn’t be able to see a stream of legal 
documents), or send zillions of attachments to fill 
up and crash the server, or simply send zillions of 
bogus requests to so overload the server that it 
can’t do legitimate work, or...

Criminals, for the most part, are not inventive. But 
cyber criminals, unfortunately, are way brighter 
than your average criminal.
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Take my email address — please!

Have you ever received an email message 
from a friend or family member that was 
forwarded multiple times, and contained 

a host of email addresses of folks you didn’t know? 
You know the kind of email  — it contains a joke, 
or a patriotic or inspirational message, and tries to 
guilt you into forwarding it to several other “victims” 
in your email address list. Figure 1 is an example 
of such an email. Well, if you have forwarded it 
without scrubbing the previous email addresses, you 
have contributed to the email address proliferation 
problem.

Now I am not suggesting that you shouldn’t be 
forwarding email, especially since those with a 
good laugh or inspiring message are, in my opinion, 
nice to pass along. But do your family, friends, and 
others you don’t know a favor by expunging them 
from the email first. The process is simple.

In an email client application, like Apple Mail, 
select the message and click the Forward option in 
the toolbar at the top. You now have a draft email 
ready to be addressed and sent, but before you do, 
sanitize your email. Go to the section where the 
previous email addresses are listed, highlight the 
addresses and hit the Delete key. Voila, content 
gone! This technique works equally well if you are 
using a Web browser and Web mail, such as Google 
Gmail.

Figure 1: This is an example of an email that has made the rounds! I guess if you really wanted to make friends  
(or enemies) you could click on an address and introduce yourself.
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There are a couple of other ways to sanitize emails you are 
forwarding. If you use Mail, the simplest is to address the 
forwarding email message using the Bcc option. (Bcc stands for 
Blind carbon copy.) This ensures that the recipients do not see 
any other email addresses. Or, if you are using the Address Book 
application, you can create a new contact group — let’s say one 
called Family & Friends — to be used explicitly for these types 
of emails. When you want to forward an email to this group, 
just start typing the first couple of letters of the group name 
in the To: address field. Mail will show you a dropdown list of 
potential addresses. Now go to Mail Preferences, Composing 
tab, Addressing section, and deselect the second option: “When 
sending to a group, show all member addresses.” Then when 
you send the email, the name of the group will appear as the 
addressee but the addresses of the individuals in that group 
will not. Figure 2, below, is an example of a message I am 
addressing to the Management Committee that does not reveal 
the email addresses of its members.

There you go: email addresses made private to give you and 
others peace of mind.

Figure 2: Here is a draft email I addressed to all the members of the Management Committee, 
without revealing individual email addresses.
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Using Spaces in Snow Leopard
By Jay Castillo

When I first read about Snow Leopard, I noticed an application called Spaces but 
passed over it, not seeing anything of interest to me. I later purchased a 27-inch 
iMac, which came with Snow Leopard installed. Wanting to make the most of the 
beautiful screen and its enormous real estate, I read one of the Taking Control 
books to help me along. That’s when I really understood what Spaces was about.  
I had never consciously performed application switching in my daily Mac sessions, 
but I realized that Spaces was a powerful and efficient application-switching tool, 
along with a lot more.

Getting Started
To begin using Spaces, open System Preferences, and select Expose & Spaces. Then 
select Spaces. This will open the Spaces preferences pane, shown in FIgure 1. This 
window allows you to configure the application.  

The first choice you have to make is how many separate screens you want to 
display on your Mac. You can have up to 16 screens, in four rows of four columns 
each. I use six screens, set up in three rows of two columns. I also chose to check 
“Show Spaces in menu bar.” This displays the number of the selected window.

Next, you have to decide which applications you want in each window. Click the 
plus sign to add an application (and the minus sign to delete). Select the applica-
tions you want and assign them to the windows you want them in. You can have 
the same application in multiple screens, operating independently of each other. 
The applications will start up when you boot your computer. This does, however, 
increase your start-up time. 

My Choices
I use Spaces to separate my work activities and always have my favorite applica-
tions available. Screen one is my starting screen. I have Safari open, with iCal and 
Mail windows just showing behind the Safari screen. With one click, I can move Figure 1. Spaces preferences pane.

Software Tutorial
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from one to the other. If Mail is invoked from Safari, it becomes 
the front-most window. Screen two is for iTunes. I go there to 
manage my music and my iPod Touch. Screen three is for iPhoto. 
I use Screen 4 for creating documents, spreadsheets, and presen-
tations. Typically, I have Pages, or Word open there. Screen 5 is for 
my alternate browser, in case I encounter a site that chokes on 
Safari (which doesn’t happen as much as it used to). I use Firefox, 
with its news site as the home page. Screen 6 is my clean screen.  
I have a mostly clear desktop, except for the relatively small Skype 
window. I use this screen for any new project I’m working on 
which uses different applications from those already opened in 
other screens.

Moving Around
It’s easy and quick to move from one screen to another. The 
Spaces preferences screen lists keyboard and mouse shortcuts you 
may wish to use to navigate. You can click on the Spaces display 
in the menu bar, and select the window number from the list 
displayed there. You can go directly to a window by holding down 
the command button and typing the number of the window you 
want. You can also cycle through the windows sequentially using 
the control and arrow keys  (right or left arrow key). While you are 
doing this, a grid of the windows is displayed, indicating which 
window is being shown.

Conclusion
For me, Spaces is an excellent workflow tool. It enables me to get 
to my favorite applications quickly, and provides uncluttered win-
dows with lots of workspace. It’s one of those things I didn’t know 
I needed until I found out about it. Try it…you might like it.

Editor’s Note: In this article, the author describes his personal 
experience using the Snow Leopard application, Spaces. For a 
detailed description of  the functionality of  Spaces, see “Twelve  
Full Monitors” in the March 2010 edition of  the Journal.

Quotable Quote:

Upgrade Advice*
Recently on the TCS* a Pi member sought advice 
about buying an iPad for his wife, but as sometimes 
happens on our members-only forum, the electronic 
conversation took off on a tangent. Toward the end of 
the message thread, there was interest expressed on 
procuring an external hard drive for back-up purposes. 
The advice flowed freely and to the point. The original 
poster said:

Member quote
“Thanks, Lawrence and Al. I have just ordered the  
My Book for Mac from Amazon ($95, free shipping).   
It sounds like the terms “idiot proof” and “hassle free” 
would apply, and this is appealing.

*Source: TCS item #4507 “Shopping advice”

Software Tutorial
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Product Review

F  ace it, we can talk about how useful Macworld 2011 was 
in terms of education and business networking (and that’s 
true), but a huge part of the enjoyment of Macworld Expo 

is seeing cool new products. Or really strange products. Either 
way, here are our picks for the best, the worst, and the silliest 
products, and those things that just tickled our fancy in one way 
or another. 

Best Way to Retrieve Files from Home 
Local network-attached storage devices seem like a great idea, 
but can be frustrating when you’re travelling. Dane-Elec thinks 
it has found a good solution for local and remote access with its 
myDitto [1], a plug-and-play network drive that uses USB keys to 
restrict remote access. Geared toward home and small business 
users with an introductory price of just $139.99 for 500 GB of 
storage, the myDitto could store all sorts of shared files—music, 
documents, photos, and the like—among a family. Authorized 
users can connect over the local network. When outside the 
local network, you install software on a computer—Mac OS 
X, Windows, or Linux flavors are supported—and plug in a 
USB dongle with an encryption key. This establishes a secure 
connection while also authenticating the user. An iOS app is also 
available for connecting to the myDitto using an iPhone, iPad, or 
iPod touch; apps for other mobile platforms are also available. 
Two hard drive sleds in the back enable you to increase the 
device’s storage capacity up to 4 TB. (UPnP port mapping may be 
required on your router. Apple’s base stations lack this protocol.)

Sleekest iPhone Car Mount 
We’ve been unimpressed by most solutions for mounting an 
iPhone in a car; they’re usually ugly or hard to use, and the last 
one we tried worked fine for the iPhone 3GS but wouldn’t hold 
the iPhone 4. The $34.99 Tetrax XWAY [4] solves the problem 
neatly, by providing a screw-tightened clamp that attaches to 
car vents, and a small X-shaped mount with four magnets in 
the center. (There’s also the FIXWAY version that you can stick 
anywhere with adhesive.) You attach another tiny rare-earth 
magnet to your iPhone or case—or to any other gadget like a 
standalone GPS navigator—and mounting your iPhone becomes 
merely a matter of letting the magnets grab onto each other. 
Tetrax is Italian, and their Web site doesn’t do a great job of 
explaining all this in English (check out the pictures in the 
Applications [5] page instead), but I’ll be buying a couple of 
these for our cars. The smaller FIX, GEO, and EGO models will 
technically work with the iPhone, but aren’t as stable as the 
XWAY. (For those with small children around, make sure the 
magnets are out of reach; they’re dangerous if swallowed.)

Best Way to Stabilize iPhone Movies  
The iPhone 4 is a surprisingly good video recorder, but like 
all small video cameras, it’s prone to vibration as you shoot 
handheld. iMovie on the Mac can compensate for camera shake, 
but there’s no such facility in the iMovie iOS app. Creaceed’s Movie 
Stiller [7] app ($2.99 [8]) applies image stabilization to any video 
you’ve shot and stored in your photo library. After a clip has been 

...a huge part of 

the enjoyment of 

Macworld Expo is 

seeing cool new 

products. Or really 

strange products.

http://www.wap.org


23 of 34

Washington Apple Pi

Journal January – February 2011

Product Review

analyzed, Movie Stiller offers controls for how much stabilization 
to apply, and can then export the finished video as a new movie 
to the Photo Library. Movie Stiller also works on the iPhone 3GS 
and fourth-generation iPod touch.

Best Impression of a Desk Phone  
AltiGen’s $149 iFusion [9] was at first inexplicable. Why would you 
want to plug your iPhone into a deskset with a corded receiver? 
In a home, it makes little sense, but in an office, the iPhone 
gains a charging dock that doubles as a speakerphone, while 
providing a comfortable handset. The iFusion can also play music 
through its built-in speakers or output it through an audio jack. 
The handset is paired via Bluetooth, so the phone doesn’t need 
to be docked to use the handset. The firm is accepting pre-orders 
in black and white!

Tastiest App (When Used Properly) 
Remember when computer companies marketed personal 
computers for storing and recalling cooking recipes? (These 
ads were usually targeted at women who, presumably, had 
no technological needs outside the kitchen. Sigh.) Although 
laptops have come closer to being true “kitchen computers,” 
the iPad may be the ideal fit: no keyboard to get in the way or 
accumulate food particles, and it can be mounted on vertical 
surfaces (like the refrigerator, using a ModulR [13] case and 
bracket), or placed in a stand. As I was browsing the mobile 
applications area of the show floor, the soon-to-be-released 
Appetites app caught my eye. Rather than present a database of 
recipes, Appetites uses videos of food bloggers explaining how 
to cook a dish from the viewer’s perspective. So, not only can 
you know how much of a pomegranate to use, but also see how 
to chop it up. (The recipes are also available without the video 
follow-along.) Unfortunately, the company behind Appetites, 
Clear Media, doesn’t yet show anything about the app on their 
Web site (total marketing failure, go back two squares), so you 
can’t get a sense of how beautifully designed the app is until 
Apple approves it for the App Store, hopefully soon.

Most Control over iPad Gaming 
Apple doesn’t offer haptic feedback on its devices yet, where 
there’s a physical response to a digital action, like pressing 
a virtual key on a keyboard and feeling a click. Haptics may 
be the future, but a set of simple plastic widgets with suction 
cups provide the sensation of feedback without complicated 
electronics. Ten One Design’s Fling [14] is a joystick-like controller 
for the iPad ($19.95 for one 
or $29.95 for a pair). A rubber 
button is mounted on a spiral 
of plastic that has two suction 
cups attached. Many games 
use touch-based joystick 
controls—the company says 
there are about 100 of those, 
which it lists on its Web site. 
Center the Fling over the on-
screen joystick controller, 
and you’re good to go. It 
seemed silly until I played 
an Asteroids-like game and 
the entire convention center 
disappeared. The Fling more 
fully immersed me, and faster 
than I would have thought 
possible. Plastics! If Fling (and 
the inevitable copycats) catch 
on, game designers could 
test against the controllers to 
improve the experience.  
(See Figure 1).

Fastest Time to Mindshare 
The fellows behind the Glif 
[18], Tom Gerhardt and Dan 
Provost, had a small booth 
where they demonstrated 

Figure 1
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and sold their iPhone tripod mount adapter. The 
$20 adapter snaps on to an iPhone 4, and contains 
a standard threaded bushing, allowing the phone 
to be used with any tripod. The adapter also works 
freestanding as a sort of kickstand. The Glif went 
from idea to reality in the space of a few months, 
raising over $135,000 through crowdfunding [19], 
and changing the lives of these young designers. I 
wrote about them a couple times at the Economist’s 
Babbage blog during their creative journey, and their 
story was written up around the world. Seeing them 
on the Macworld show floor was a treat. (See Figure 2).

Best Way to Clean Your iPad Screen  
Without Newspaper  
The folks at LensPen, who make a variety of screen- 
and lens-cleaning products, gave non-stop demos of 
the SideKick, a new touchscreen-cleaning device. The 
SideKick looks and feels like a small, smooth chocolate 
bar. You split it in half, and a carbon-laden cleaning 
pad on a short handle pops out. Run the pad over an 
iPad screen and the carbon soaks up the fingerprint 
oils. When you finish, you put the pad back into 
the case, which also somehow reconditions it. You 
reportedly get about 150 uses per pad. I tried the 
SideKick on my iPad, and it worked well. The LensPen 
booth rep claimed the SideKick is based on the same 
chemistry employed when you clean a window with 
a wadded-up newspaper, but I found newspaper 
significantly more awkward and slow to use. I can’t 
find anything about the new SideKick on the LensPen 
[21] Web site, though the company does mention it on 
their Facebook page [22]. If you want a SideKick but 
missed the opportunity to buy it at Macworld Expo, 
you’ll have to look for it through distributors a little 
later this year. The price should be around $20 for the 
device plus one extra pad.

Smallest Projectors 
Two companies were showing iPad-, iPhone-, and 
iPod touch-compatible pico projectors, which are a 
relatively new category of display. A pico projector 
uses one of several alternatives to standard projection 
bulbs, and runs cool. Pico projectors are designed to 
be much smaller than the units you see in conference 
rooms, but they can produce a passable large image 
in a dark room, and often a good small image in a 
lighted room. The brightly lit show floor is a tricky 
place to view such projections, and both devices were 
impressive in those conditions. Microvision revealed 
its $399.99 Showwx+ [26], which connects via a dock 
cable. The $479 Neo-i [27] from Optoma is larger, 
working as a docking station with speakers that can 
play music or project from its built-in pico system, 
as well as provide VGA and HDMI video output. You 
can watch a demo [28] of the Neo-i from Macworld. 
Both rely on iOS’s built-in video output 
options; no apps or tweaking is required.

Real Product That Sounds  
Most Like a Parody 
You’ve tried slicing, you’ve tried dicing, 
but you’ve never tried sticking a 
television on your head! Now you can! 
The $29.95 TV Hat [29] was the goofiest 
product we saw on the show floor. It’s 
a hat-based mount for an iPod touch 
or iPhone designed to shade the screen 
from light and place it far enough away 
to focus your eyes through a special lens. 
None of us could bring ourselves to try 
it, possibly because of its “As seen on 
TV” badge. Or because we were afraid 
someone would take our picture while 
we were testing it. It’s that silly looking.

Figure 2.
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Expand Reading on Your iPad
by Roy Wagner

iPad Software Tutorial

Editor’s Note: The article below is based on a presentation given at the October 23, 2010 Washington Apple Pi General Meeting.

I am a real iPad enthusiast, and I have found the iPad to 
be an enjoyable device for reading. The usual fare for 
reading is eBooks; there are other options, however, such 

as magazines, newspapers, comics and graphic novels. This 
article describes some of these other options and how you can 
access them. I also explain how to add PDFs to the iPad, and, as 
a bonus, another reading option — the use of RSS (Real Simple 
Syndication) readers.

Magazines
The iPad is a new and attractive platform for magazine 
publishers, and magazines are now becoming available for it. 
These electronic periodicals can be interactive, showing videos, 
playing audio, and doing so much more. Even the ads are more 
attractive. Zinio is one of the major iPad publishers and offers 
many magazines for the iPad (at high per issue prices). Wired 
magazine is probably one of best. Dale Branson, of Virgin Airlines 
fame, has just introduced Project, his iPad magazine. It is quite 
impressive, but expensive at $2.99 per issue. A major problem, in 
my opinion, is that book, magazine, and newspaper publishers 
charge way too much for singular iPad editions, and do not 
currently offer reasonably priced subscriptions.

Newspapers
Several newspapers are currently available for free on the iPad. 
Among them are USA Today, The Wall Street Journal, The New 
York Times, The Washington Post, and The Telegraph (a leading 
U.K. newspaper). The common denominator for these publishers 
is that they are trying to figure out how to charge the iPad user 
for their papers. None of them appear yet to want to work with 

Apple to provide a reasonable subscription service. Rupert 
Murdoch is working with Apple, however, to come out with a 
weekly subscription to The Daily (which is currently available 
for free). The subscription is expected to be 99 cents, and to be 
available sometime soon (probably in 2011).  

In my opinion, newspapers on the iPad are much better than 
the print versions. However, none of the iPad editions, to my 
knowledge, contains all the content of the printed version. I think 
this is in part a bandwidth issue. It is regrettable because all these 
newspapers are much easier to view on an iPad; you don’t have 
to spread them out all over the table or in your hands. They can 
also include more color photos and videos, and links to greater 
content and reader feedback.

In my opinion, 
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All of these newspapers require Internet access to get the content, 
and some of them do not allow their content to be saved to your 
iPad for later unconnected reading.

Comics
If you are a comic book reader, the iPad is the best media device 
for reading comic books or graphic novels. The display with an 
iPad is slightly smaller than the hard copy comic book, but each 
frame can be easily viewed with an expanded view that is truly 
awesome. There are three major comic book apps, all of which 
use the same interface: Comixology, Marvel, and DC Comics. If you 
haven’t looked at a comic in years, you should look at one on 
your iPad; all of these apps offer several comics for free.

Adding PDFs
Adding PDFs to an iPad is easy. Start in iTunes on your Mac and 
drag-and-drop any PDF into the top-most LIBRARY section. The 
next time you sync your iPad those PDFs will appear in the iBooks 
PDF section. In some cases, certain PDFs do not display their 
embedded images. If this happens, simply open the PDF file in 
Preview, select File > Save As, and save it as a PDF. Now, add this 
new file to iTunes, and the images should be displayed.

Being able to add PDFs to iBooks is a great feature because so 
many documents are available as PDFs or can be made into PDFs 
with other software. The problem with PDFs, however, is that 
you cannot highlight text in a PDF or use other iPad text-tapping 
enabled options as you can in standard ePub (iBook) files. We can 
only hope that this shortcoming will be remedied in the future.

While PDFs can be viewed using the iBook app, some PDF files, 
like those from LensWork, can be better viewed using other iPad 
PDF viewers such as GoodReader. This app is more versatile and 
it can do much more than just allow manipulation of PDFs. More 
details are available at the Good.iWare Web site. 

RSS Readers
RSS readers were always difficult for me to use or view on my 
computer. However, RSS feeds are very easy to add and view on 
the iPad, with a multitude of apps. Most of these will use the 
RSS feeds you may have set in GoogleReadeR. Personally, I like 
Early Edition because it displays the RSS feed in a newspaper-like 
display. Other popular readers are Reeder and Pulse.

And as my final recommendation, another impressive “reader” 
is Flipboard. It combines Facebook, Twitter, and RSS feeds into a 
single magazine-like format. Very impressive; check it out!

iPad Software Tutorial

The display with 

an iPad is slightly 

smaller than the hard 

copy comic book, but 

each frame can be 

easily viewed with an 

expanded view that is 

truly awesome.

http://www.goodiware.com/goodreader.html
http://www.wap.org


28 of 34

Washington Apple Pi

Journal January – February 2011

Comic Pi

http://www.wap.org


29 of 34

Washington Apple Pi

Journal January – February 2011

Tips & TricksT
ip

s Tr
ic

ks

&
Figure 1.  
The TextEdit application 
has a text correction 
feature. In this example, 
typing d-y-s- and then 
tapping the Escape key 
renders a long list of 
possible matching words. 
Use the arrow down key 
to go to the word you 
want, hit Enter, and keep 
typing. Cool.

TextEdit Autocorrect, Adding to a PDF, and more . . .
See if any of these “tricks of the trade” make your computing a tad 
more productive.

1. Spelling corrections in TextEdit
Did you know that all versions of Mac OS X include a word processing 
application? The program is called TextEdit, and in the most recent 
Leopard operating systems, TextEdit has an added capability that 
matches what can be found in the more expensive and elaborate word 
processing programs like Microsoft Word. Check out this tip.

Auto completion is a search feature that initiates a search with the 
first keystroke. With each typed letter, the auto-complete feature in 
TextEdit will provide words that match them. To activate an auto-
complete window, simply start typing a word and press the escape key. 

A window will pop up listing all of the words starting with the letters 
you entered. You can use the arrow keys to go up and down the list. 
Pressing enter/return completes the word in your TextEdit document. 
If there are too many words in the auto-complete list, you can type 
additional letters (without having to manually close the auto-complete 
window) and hit the escape key again to bring up the auto-complete 
window with the filtered-down choices. Pressing escape while the 
auto-complete window is open will close it. Can’t remember how to 
spell dysfunctional? See Figure 1.

2. Adding an image to a PDF
Have you ever wanted to add something to a PDF document but didn’t 
have (or want) Adobe Acrobat to meet this need? Guess what, the Mac OS 
X 10.6 version of Preview can do it for free! It just takes five easy steps.

Open the application Preview and proceed as follows:

1.	 Convert the PDF document to an image with File » Save As.... 
Choose PNG as the format and change the resolution as desired.

2.	 Open the image file you want to insert in the PDF and select the 
whole image with Edit » Select All (command – A) or by using the 
mouse.

3.	 Copy the selection Edit » Copy (command - C).
4.	 Go back to the document — the PNG image — and paste the 

selection with Edit » Paste. Resize as necessary.
5.	 Save the file as a PDF with File » Save As.... Choose PDF as the 

format. You may want to rename it if the original PDF needs to be 
preserved.

Note: The PDF made from an image is not searchable, so that is one 
drawback to this procedure.

This process has not been attempted in earlier versions of Mac OS X, 
but even if you don’t have Snow Leopard, give it a go.

http://www.wap.org
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3. Quickie Typing Tip
If you do a bit a typing you may relate. Does your typing rhythm get thrown off 
when you have to use the harder-to-access top row of keys — e.g., typing open and 
closed parentheses? The next time you need them, try this: type them in sequence 
like this (), one after the other. Next, click the arrow left key just once to place the 
cursor between the parentheses, and continue typing the text that needs to be 
enclosed. When done typing click the enclosed text, click the arrow right once, type 
a space, and continue on your merry way.

It could be argued that this adds a couple of unnecessary keystrokes (arrow 
left and arrow right), but the arrow keys are more in line with the area of the 
keyboard most used, so your fingers have less distance to travel. And, there is a 
gain from having to only press the Shift key once while typing the open and closed 
parentheses keys in sequence. It works for me; see what you think.

Oh, it works when using quotes too!

4. Finding Downloaded Files
Have you ever downloaded a file (or two or three) and then been unable to find 
them in your Downloads folder (or wherever else your downloads might be going)? 
Contributing to the dilemma, you didn’t note the file name and, if you are like me, 
you have tons of previously downloaded files so it is now a case of “by guess and 
by golly.” What to do? The steps are rather easy.

Start by opening the folder that contains your downloaded files. Select List view 
(you know how to do that, right?). Click on the 2nd column header labeled Date 
Modified. All the files should be listed in chronological order with the most recent 
at the top. Not there? You may have the dates in reverse order; click the column 
header title again to reverse the order. Still don’t see it at or near the top of the 
list? then the file you downloaded has a file date that is a wee bit older than 
today’s date. In that case, you will have to read down the list a little way to see if 
you can recognize the file name.

Of course, there is another way, and that is using SEARCH FOR in the Finder 
window sidebar. This gives you an option of searching by date (today, yesterday, 
past week). If the download occurred recently (today or yesterday), merely clicking 

on that option and highlighting the Last Opened column header will reveal in 
chronological order every file or application you opened. Now all you need to do is 
to recall about when you did the deed.

Happy hunting!

Do you have some tricks of  your own? Let us know so we can share with the other 
readers; just use the feedback option at the bottom of  page 2.

Figure 2. Where’s that file I just downloaded? Displaying your download folder in List 
view and selecting the Date Modified should produce a list of downloaded files from 
latest to oldest. 

http://www.wap.org


Members Helping Members

Dedicated volunteers are the lifeblood of the Pi. Whether it is installing a hard drive at a Clubhouse Saturday event, answering  
questions at a General Meeting, or placing advice on the TCS Forums, there are many ways to pitch in and help, depending on a  
member’s interests and talents. Please consider making a commitment to ensure that the Pi remains a strong, viable, and  
energetic club dedicated to helping its members. For certain, all volunteer efforts are appreciated. Check out these areas  
where assistance is needed.

Featured Position –  
Journal Managing Editor
The Journal is a time-honored, well established publi-
cation of the Washington Apple Pi and it is in need of 
someone to take over as Managing Editor. In addition, this 
person will be a member of the Pi’s Publications Commit-
tee, which has oversight and responsibility for all printed 
material and electronic messages that emanate from the 
Pi. The job is challenging, but very rewarding.

If you enjoy writing and want to help the Pi progress, this 
is the job for you. Apply within!

Contact robert.jarecke@wap.org with any questions or 
to express your interest.

iChat Help Volunteer

Apple’s iChat application offers a way for Pi members to help other 
members from the comfort of your own home. Interested? Read on.

iChat is an ideal means for direct communication using text, voice, 
video, or, in the last two versions of Mac OS X, screen sharing. With the 
Pi having commercial grade servers and server software, we now have 
the means to host our own iChat network. We are currently testing the 
capability of this interactive networking software, and the first results 
are positive.

So what will Pi iChat Help volunteers do? Essentially, the task is much 
like other help scenarios in which members have questions or a prob-
lem. But instead of a face-to-face encounter, the primary means for 
handling the matter will be use of the versatile iChat software. What’s 
that? You don’t use iChat or haven’t even launched it yet? No problem, 
we will train you. We will also be providing guidance on how to deal 
with common issues, and on problem-solving techniques, and will sup-
ply a list of associate helpers who can help with particular issues. All 
you need to bring to the equation is your people skills and a genuine 
desire to help.

If you have even the slightest interest or any questions, contact the 
Management Committee Chair, Jay Castillo, at president@wap.org.

Volunteer Opportunities
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General Meeting Manager
Our General Meeting programs need someone dedicated to 
the planning and managing of these important club events. 
The job includes coordinating meeting activities, making 
any necessary arrangements, and managing the behind-the-
scenes specific tasks. While it sounds like a job for Superman, 
that really is not the case. If you have juggled household 
duties or been an office administrator, you have the skills. 
While another Pi manager emcees the meeting, you will be 
making him or her look good!

Because this activity needs to be approved by the Pi’s 
Management Committee, the volunteer will serve as 
an adjunct member of that committee. This volunteer 
opportunity is guaranteed to keep you busy, and when the 
meeting is completed and meeting equipment packed up, 
lunch is on the Pi.

Send your inquires to robert.jarecke@wap.org.

Pi Fillings Editor

We need someone to take over producing the Pi Fillings discs. 
Pat Fauquet has been doing it for years, but it’s time for 
someone else to lead the charge. Are you up for it?

We are reviewing the current format and publication cycle of 
the software disc. We are interested in diversifying the content 
and are open to suggestions on how to add value to the disc. 

No previous experience is needed; we will train you. Some of 
the tasks that you will need to do are to search out interesting 
and pertinent material and files, organize the disc with the 
mined material and with other files supplied separately, and 
design a label for the disc. The production process will be 
separate and is not necessarily part of the job.

Contact office@wap.org to express interest and we’ll go  
from there.

CLASSIFIEDS:

Seeking: 

iPhone Developer for new projects and app 
updates.

Have some time and experience? let me know! 
r.huttinger@wap.org.

mailto:r.huttinger@wap.org
http://www.wap.org
http://www.wap.org


33 of 34

Washington Apple Pi

Journal January – February 2011

The details are as follows:

Who: Roy Wagner will head up 
the Mobile Lifestyle SIG with able 
back up from Larry Kerschberg 
and Travis Good. As for who can 
join, anyone with an interest 
in learning more about mobile 
computing is welcome.

What: The primary focus will 
be on Apple devices running iOS 4 (and later versions). 
The touch operating system has its own nuances worth 
investigating. However, the apps that run on the devices 
will get the lion’s share of attention.

When: The SIG will meet immediately after the monthly 
General Meeting. The duration of the meeting will be one 
hour or longer, depending on the agenda and interest.

Where: George Mason University in the same location as 
the General Meeting.

Why: To learn more about mobile computing with fellow 
Apple enthusiasts and to have fun while doing it.

One more thing …
The Mobile Lifestyle SIG
There’s a new kid in town and it’s a new Pi Special Interest 
Group.

From the advent of the first generation iPod to the 
newly released iPad, Apple has long been touting mobile 
computing. Apple’s mobile, handheld devices have evolved 
considerably to where you can do almost anything on an 
iPhone, iPod touch, or iPad. Boy, how things have changed!

And, as often is the case, there are Pi members who are 
leading the charge in learning how to use these new 
gizmos and adapting them to their computing needs. 
Furthermore, these members are willing to share their 
wealth of experience and expertise in a semi-formal setting 
with all interested others.

Parting Words

http://www.wap.org
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